4

Getting Started
Install Ghidra
MDK-ARM
Memory Requirements
Ghidra
Examining Object Code and Control Flow
Ignoring Control Flow
Simple Control Flow
Complex Control Flow
Examining Function Calling Behavior
Linker Static Call Graph
Ghidra
Source Code vs. Decompiled Code



Scroll down to the last two sections in the map file to determine the following values in bytes (not kB).

1. Whatis the Total ROM Size in bytes?

2. What is the Total RW Size in bytes? This is the total RAM required.

3. What s the size of RW Data in RAM in bytes? Note this is uncompressed RW Data (in Grand Totals).

4. What is the size of RW Data in ROM in bytes? Note this is compressed RW Data (in ELF Image Totals (compressed)).
5. How much ROM space in bytes is used for code?

6. How much of that ROM space is used for included data (e.g. literal pools, listed as “.inc data”)?

Code (inc. data) RO Data RW Data ZI Data Debug
20020 1352 4832 3 1068 9480 217705 Grand Totals
20020 1352 4832 9480 217705 ELF Image Totals (compressed)

4832 312 0 @ ROM Totals

Total RO Size (Code + RO Data) 24852 ( 24.27kB)

Total RW Size (RW Data + ZI Data) 2 10548 |( 10.30kB)

Total ROM Size (Code + RO Data + RW Data) 25164 | ( 24.57kB)



Examine the Local Symbols section.

7. Which is the largest symbol of type “Thumb Code”, and how large is it in bytes?
8. Which is the largest symbol of type “Data”, and how large is it in bytes?

Examine the Global Symbols section.

9. Which is the largest symbol of type “Thumb Code”, and how large is it in bytes?
10. Which is the largest symbol of type “Data”, and how large is it in bytes?

| 4981 [7 schthhreadNew] 0x00004821 Thumb Code/ 484 |rtx_thread.o(.text.svcRtxThreadNew)

|5046 [8 0s_mem ] 0x200005c8 Data 840896 |rtx_lib.o(.bss.os)
5245 (9 dmul ] 0x000009c9  Thumb Code9 558 |dmul.o(.text)

| sa16 [ 10 Lucida_Console12x19] 0x000050e0 Data 10 3831 [lucida_12x19.0(.rodata.Lucida_Consolel2x19)




Examine the first part of the Image component sizes section to determine the memory requirements of the program
objects.

11. Which object member has the largest component of type “Code (inc. Data)” (first column), and how large is that
component?
12. Which object member has the largest component of type “RO Data”, and how large is that component?

13. Which object member has the largest component of type “RW Data”, and how large is that component?
14. Which object member has the largest component of type “ZI Data”, and how large is that component?

Code (inc. data) RO Data RW Data Z1 Data Debug Object Name
456 76 (4] 1 36 5595 adc.o
%] 0 0 27 3 1020 colors.o
1176 166 %] 88 3861 10391 control.o
80 12 108 0 0 2061  debug.o
32 4 ] (%] (%] 797 delay.o
180 48 (%] 0 17 4633 dma.o
476 110 36 10 4 7484  fault.o
32 0 0 0 0 1413  fx.o
542 0 ] 0 0 5183 lcd_graphics.o
768 48 6 12 20 5515 lcd_text.o
164 32 (4] 0 0 2109  leds.o
) 0 C 0 502121lucida_12x19.0 |
104 12 0 1 0 1078 main.o
140 32 (%] 0 20 3614 profile.o
0 0 36 0 4 728 region.o
4 (%] 0 0 (%] 714  rtx_config.o
16 4 ] 0 0 633 sound.o
80 44 192 (] 256 940  startup_mkl25z4.0
224 44 ] 4 (%] 3266 system_mkl25z4.0
232 a4 108 0 16 3491 threads.o
308 40 (] 4 0 6297 timers.o
448 44 (4] 17 0 3411  touchscreen.o



Code (inc. data)

164
126
132
71e
244
156
151e
922
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392
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20
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20
8
56
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Examine the second part of the Image component sizes section (with the last column Library Member Name) to determine

the memory requirements of the library member objects.

15. Which library member has the largest component of type “Code (inc. Data)” (first column), and how large is that
component?

16. Which library member has the largest component of type “RO Data”, and how large is that component?
17. Which library member has the largest component of type “RW Data”, and how large is that component?
18. Which library member has the largest component of type “ZI Data”, and how large is that component?

RO Data

DO OOO
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S N ®
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D00 OOOFO

D00

RW Data

ZI Data

Debug

658
2812
2729

15

438

P3] /rtx_kernel.o

Library Member Name

irq_armvém.o
os_systick.o
rtx_delay.o

rtx:mempool.o
rtx_msgqueue.o
rtx_mutex.o

em. o

315096] 5 rtx_thread.o

996 rtx_timer.o

e
638

__dczerorl2.o
main.o

616:printf_flags_ss_wp .0

e seo)

[y
g?\'oggooooo

__rtentry.o
__rtentry2.0
__rtentry4.o
__scatter.o
__scatter_zi.o
_printf_char.o
_printf_char_common.o
_printf_d.o
_printf_dec.o
_printf_intcommon.o
_printf_pad.o
_printf_percent.o
_printf_percent_end.o
_printf_s.o
_printf_str.o
_printf_u.o

_snputc.o

_sputc.o
aeabi_sdivfast.o

[
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28RS

186

1e

68
12
62

46
1es8
88
584
348

1ee
76
43
94

176
16
94
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[EEY
00
[Xed
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68
136

SIS IR

160

68] 8 libspace.o

exit.o
heapauxi.o
indicate_semi.o
libinit.o
libinit2.0
libshutdown.o

mul.o
noretval__ 2snprintf.o
noretval__ 2sprintf.o
rt_memclr.o
rt_memcpy.o

rtexit.o

rtexit2.o

rtudivle.o

strlen.o

sys_exit.o
sys_stackheap_outer.o
use_no_semi.o
cmpret.o

dfixi.o

dflti.o

dmul.o

faddsub.o

fcmp.o

fcmpin.o

ffixi.o

ffixui.o

fflti.o

fgef.o

fmul.o

fnan2.o0

retnan.o

usenofp.o
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In Ghidra, open the Functions window (Window -> Functions). Click on the Function Size to sort by size.

19.
20.
21.
22.
23.

What are the name and size of the largest function?

What are the name and size of the second-largest function?
What are the name and size of the third-largest function?

Do this information match what you found above in the map file?
Does Ghidra differentiate between local and global symbols?

X

]

&

Location

|Function Signature

\Function Size v

Name
19 _dmul 000009c8
20 LCD_D]'aw_Line 000016d0

| 21/svcRtxThreadNew| 00004820
LCD_Text_PrintChar 000021d0
Control_HBLED 000010d8
svcRtxMessageQue... 0000427c
LCD_Fill_Rectangle = 00001a20
LCD_TS_Read 00001194

undefined dmul ()

void LCD Draw Line(P...
osThreadld & sveRtxT. ..
woid ICD Text PrintC..s
undefined Control HB...
osMessageQueueId_t S e
void Lep I EITINReetan: ..
uint32 t LCD TS Read...

19 558
20 5%
436
428
428
418

394



24. What are the name (label) and size in bytes of the largest data item in memory (not in _elf*, .symtab, .strtab,

.debug_frame, .comment, etc.)?

25. What are the name (label) and size in bytes of the second-largest data item in memory (not in _elf*, .symtab, .strtab,

.debug_frame, .comment, etc.)?

26. What are the name (label) and size in bytes of the third-largest data item in memory (not in _elf*, .symtab, .strtab,

.debug_frame, .comment, etc.)?

27. Does this information match what you found above in the map file? If not, try to explain the difference.

Locatlon

Data Type Size ¥ Label

?? 200005¢8 uint64_t[512] [24 4096 os_mem |

" 000050e0 uint8_t[3831] | 25 3831 Lucida_Console12x19 |
?? 1ffffe00 uint16_t[960] [ 1920 g_set_sample ]

?? 1ffff600 uint16_t[960] 1920 g_meas_sample

22 20001908 undefined1[256] 256 Heap_Mem

?? 200017d8 uinté4_t[32] 256 os_timer_thread_stack
2? 200016d8 uint64_t[32] 256 os_idle_thread_stack
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For the following questions, look in the disassembly window to see the object code which implements the function.

1. Which is the first instruction of the function Multiply_ FX? Include address, machine code, opcode and operand.
ECE 561 Only: Enter the start address of the function from the disassembly window and the start address for the
function listed in the map file. Explain why they don’t exactly match.

When BL.W __aeabi_lmul executes, which registers hold variable pa?

When BL.W __aeabi_Imul executes, which registers hold variable pb?

N

Immediately after BLLW __aeabi_Imul completes, which registers hold variable p?

o v AW

Which instruction performs the return-from-subroutine? Include address, machine code, opcode and operand.



push
asrs
asrs

~r
WY

bl

lgnoring Control Flow

Arguments longer than 1 word are ordered

little-endian in registers or memory
Register Contents After Instruction Executes

ro (“a”) rl (“b”) r2 r3 rd4
a b
a b pa MSW sign extend a to get pa bits 63-32
a b pb MSW | pa MSW sign extend b to get pb bits 63-32
a b b |pbMSW | pa MSW
a pa MSW b |[pbMSW | pa MSW
p LSW p MSW r0, rl as two words
p 3" MSHW| p LSHW p MSHW | p 2"MSHW r0, rl as four half-words
b 3MSHW| pLSHW | p 2/9MSHW 0 shift p MSW left to get lower halfword,
zero out upper halfword
0 b 3MSHW | p 27MSHW 0 shift p LSW right to get upper halfword,
zero out lower halfword
b 209MSHW | p 39MSHW | p 279MSHW 0 OR together resultzftz get middle 32 bits




Signed 16.16 * 16.16 Explained .

PUSH
ASRS
ASRS

MOV
MOV

BL

LSLS
LSRS
ORRS

POP

{rd. 1x}
A i3]
7 adks (PO (PO

5 5 A |
rl,r4d

aeabli Ilmul

st I, 0 BB 5 Y
Ra t 0y o o 0 Y
i {0 o, I A

itd.pc}

b
* Sign-extension to 64 bits r0 rl
* a(r0)and b (r1) to 64 bits pa (r4:r0) -
and pb (r3:r2) A [0 < 3 1
* ASRS: arithmetic shift right performs —~——
sign extension by setting all of upper
word’s sign bits to match lower word’s 1 Y r0 3 Y 2
sign
« Move pa and pb into argument \/
registers (r1:r0 and r3:r2) __aeabi_Imul
e Call __aeabi_Imul for long multiply ( @{\ {//fw O
A 4 r
* Extract middle 32 bits of result
v,
* LSLS: logical shift left extracts lower 16 1
bits of rl ‘
* LSRS: logical shift right extracts upper y
16 bits of r0 K r0

ORRS: merges together middle 32 bits

ri
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Simple Control Flow #7 (v1.0): CFG of
Fault Fill Queue

* 2 or 3 basic blocks ok since bl
osMessageQueuePut may be
interpreted as ending basic block

* Note that there should not be a
basic block for the subroutine
osMessageQueuePut. The call
instruction (BL) is in the 2" basic
block.

BBs yes- yes- yes-
branch | call return
3 1 1 1 0

2

1

1. 0x1418

2.0x1424

3. 0x1436

1

0

1. 0x1418

2.0x1424

Eﬁ-anb_e -0 MW

w.29a8 str

~.2%aa ldr

«w.29a€ movs

switchD_000025la::...
t,$0x0

t, [sp,$local_18]

x5, [->ADC_RequestQueue]

A

=

0

«e29b€ mov rl,r4
«:29b8 mov r3,x2

«.25ba bl

«.25be ldrb ¢

«e29c0 b

LAB 00002%ac




Simple Control Flow #8 (v1.0): CFG of

Fault Fill Queue

e 2 or 3 basic blocks ok since bl
osMessageQueuePut may be
interpreted as ending basic block

* Addresses should match basic
blocks listed in #7, not
necessarily what’s in this
diagram.

* Labeled edges connecting basic
blocks as shown

* Note that there should not be a
basic block for the subroutine
osMessageQueuePut. The call

instruction (BL) is in the 2" basic
block.

1. Ox

1418

A

2. 0x

1424

A

3. Ox

1436

7

1. 0x1418

A

///;.0x1424

\

00002936 - caseD_e

)
w
"

o

w oW oW

w ow oW

W W o
"

| 000025ac - LAB_000029ac

w.29%ac adds t,t,$0xl

«:29b4 movs . $0x0
«:29b€ mov
«:25b8 mov
«.25ba bl

we2%ae add » , 8024
«e29b0 strb t, [r4,$0x0]=>local_lc
e29b2 1ldr ¢, [x5,$0x0]=>ADC_ Requestu...

«:25be 1ldrb t, [r4,$0x0]=>local_lc
«:29c0 b LAB 00002%ac




Simple Control Flow #7 (v1.1+): CFG of
Control DutyCycle Handler

BBs yes- yes- yes- 1. 0x10a8
branch | call return .
5 2 2 0 1

5 1 2 1 1 2. OXlObO
* Note that there should not be a 3. 0x10c2
basic block for the subroutine

PWM_Set_Value. The call
instruction (BL) is in the 4t basic 4. 0x10c4

block. ;
/

5. 0x10d6




Simple Control Flow #8 (v1.1+): CFG of
Control DutyCycle Handler

* 5 basic blocks, labeled as shown

* Addresses should match basic
blocks listed in #7, not necessarily F
what’s in this diagram.

1. 0x10a8

* Labeled edges connecting basic 2. 0x10b0
blocks as shown \
* Note that there should not be a T |
basic block for the subroutine “ 3. 0x10c2

PWM _Set Value. The call | A
instruction (BL) is in the 4t basic |
block. 4. 0x10c4

LA

5. 0x10d6
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Complex Control Flow #9

e Should show the right function
(LCD_Start_Rectangle) using
this layout

* Text doesn’t have to be legible,
but basic blocks and control
flow edges must be visible



Complex Control Flow #11

* Must be from Ghidra for Test_Fault
* May be a different layout from this one

* Must show basic blocks and edges




Complex Control Flow #12
s

@ o0

switchD_000029l1a::...
«.2990 movs t,#0x2
2992 bl osDelay
2996 str r4,[r5,#0x8]=>DAT_£E80££048
2998 add sp,#0x10
.299a pop {r4,rS5,r7,pc}

Wy ¥

M




Complex Control Flow #15 (Overview)

Jump Table

Address
0000291c 06 db ¢h
* Test case number t (in r0) is decremented by one, since table has pass 1r) 0000291d 0b db  Bh
covers cases 1 through 14. Example:t=3,s0r0<-3-1=2 vt e e s 0000;9; ’;‘ dd; -
«.28fc 1ldr >DBG_Bit 0 10h
* r0is compared to the largest test case offset Oxd (14-1=13),and  "2.> = if el ol o | oooozfif 4 & 1
the result determines if bhi branches. 2902 mov 4, piopiigllibendibic
D T D 0002922 1d  db  1Dn
e r0>13? 2906 ldr osbo2923 25 b 2sn
* branch to caseD_e, which is code following last case e ifz /'32333222 fb x “=:
statement, since there is no default case +290c ‘subs =0, 20, $0x1 &4 oooo2926 32 @ 32
_ ) B B ..290e cmp r0,#0xd 4 E KR
e r0<=13?Ex:r0=2<=13 ..2910 bhi switchD_000029la::caseD_e /’ gzggizzz zi i “i:
* Note: pc is address of cur. instruction + 4. Arm Arch. Ref. / 0002525 24 db  iin
Manual, DDI 0419C l ’
Read the PC value, that is. the address of the current instruction + 4. '@u T o~ ™
* Add pc to r0, so r0 points to ... Ex: r0 <- 2 + (0x2914 + 4) = e _ | et J/
0x2918 + 2 = 0x291a _a-2916 1drb x0, [x0, $0x4¥>switchDs+
* Load register rO with byte from entry in jump table (in ~__.-="" . T5 0 Ll
memory at address r0+4). Ex: r0 <- memory[0x291a+4] = //
memory[0x291e] = Oxd =13 g \
P N =
* Shift rO left by one bit (multiply by two) to convert offset to E” i — O X
bytes. Ex: r0 <- 26 — switchD_0000291a: fuee |
* Add r0 to pc, causing the program to jump to that case’s g — \ﬁ s -0 M|
code. Ex: pcC <- (0x291a +4) + 26 = 0x291e + 26 = 0x2938 e e ) switchD_0000291a: :...
--------- »|...2938 1ldr t,[->g_flash_period]
...293a movs rl,#0xé4
«:293Cc b LAB_0000298e




switch (t) {

0
1

2

3.
4

5
14

8
6

11

12
13
10

15
}

~

case TR None:
break;
case TR_Setpoint_High:

g_set_current = 1000;
break;
case TR_Setpoint_Zero:

Tt .Complex Control

L]
// Manually change current Setpoir
g_set_current = 0;

break;
case TR_Flash Period:
g_flash period = 100;
eak;
case &R PID FX Gains:

// Co t one of the compensator gains
plantPID}‘wiGain = -1000;
break; ~

case TR_LCD_muce\xx
// Take LCD mutex, 9on't return it
osMutexAcquire (LCD m\h@:, osWaitForever):;
- ~

break; ~
case TR Fill Queue: \\
// Fill ADC request queue wlthﬁ{rbage
Fault_Fill Queue(); ~
break; \\
case TR_Disable_PeriphClocks: \\

SIM->SCGC6é = 0;
break:;
case TR Disable_All IRQs:
// Disable 4
__disable_irqg():
break:;
case TR _Disable ADC_IRQ:
// Disable ADC interrupt
NVIC DisableIRQ(ADCO_IRQn):
break;
case TR_osKernelLock:
// Lock kernel - don't let other tasks run
// See details at https://www.keil.com/pac
osKernellock():
break;
case TR_Change MCU_Clock:
// Change MCU clock frequency
MCG->CS = 0x0018;
break:;
case TR_Slow TPM:
TPMO->MOD = 23456;
break:;
case TR_Stack Overflow:
n = Overflow_Stack():
break:;
case TR_High Priority Thread:
// Raise own priority very high, then go i
osThreadSetPriority(osThreadGetId(), osPri
while (1)
DEBUG_TOGGLE (DBG_FAULT_POS) ;
break;
case TR_End:
break;

Tnrterrunts
Interrupts

© 00 N O U B W N L O

[ =
w N Rk O

0x291a +4 + 2*0xD [
=0x2938 [ o
switchD_000029l1a: :swiyéhda oz
0000291c 06 db €éh [,/
0000291d 0b db Bh ,/
0000291e 0d db Dh/ utuasie
0000291f 10 db 10h
00002920 14 db 1l4h fortce
00002921 1b db 1Bh
00002922 1d db 1Dh suasss
00002923 25 db 25h hreri
00002924 28 db 22h
00002925 2b db 2Bh
00002926 32 db 32h
00002927 36 db 36h
00002928 3f db 3Fh fosbien
00002929 44 db 44h

1b

00
0f

0od

£0

£3
£3

43

21

£0
el

switchD_0000291a::caseD_1

1 movs
1sls 0
1dr » [->g_set_current]
str r0, [rl,#0x0]=>g_set_current
b switchD_0000291a::caseD_e
switchD_0000291a::caseD_2
2 ldr r0, [->g_set_current]
b LAB_0000296a

switchD_0000291a::caseD_3

3 ldr r0, [->g_flash_period]
movs rl,#$0x64
b LAB_0000298e

switchD_0000291a::caseD_4
4 ldr r0, [->plantPID_FX]
ldr

rl,[__arm cp.2_11]
str rl, [x0,#0x14]=>DAT_1£f£f££418
b switchD_0000291a::caseD_e

switchD_0000291a:

5 ldr

:caseD_S
» [->LCD_mutex]

ldr , [0, $0x0]=>LCD_mutex
movs
mvns
b7 fd bl Acquire
b switchD_0000291a::caseD_e

switchD_000029la::caseD_¢€

6 cpsid 4

b switchD_0000291a::caseD_e

switchD_0000291a::caseD_7

1sls

ldr +[__arm cp.2_6]

str r0, [r1l,#0x0]=>DAT_e000el80
4f 8f dsb #0x£
6f 8f isb #0x£

b switchD_0000291a::caseD_e

switchD_0000291a::caseD_8

8 ldr r0, [__arm_cp.2_7]
LAB_0000296a
movs rl, $0x0
b LAB_0000298e

switchD_0000291a::caseD_9

fd9bl
b

KernelLock
switchD_0000291a::caseD_e

00002974
00002978
0000297a

0000297
00002980

00002982
00002984
00002986
00002988

0000298a
0000298c

0000298e

awitchD_0000291a::caseD_a

9% 10 bl osThreadGetId
movs rl, #0x30
bs fa bl osThreadSetP:
LAB_0000297e
str r4, [£S, #0xc]=>DAT_£20££04c
b LAB_0000297e
switchD_0000291a::caseD_b
1 1 ldr
movs
strb rl, [r0, #0x0]=>DAT_40064004
b switchD_0000291a::caseD_e
switchD_0000291a::caseD_c
752, (20, $0x0]=

switchD_0000291a::caseD_e

0 15 No code for these cases

Code after switch (t){ ... }

-
3

0000299¢c
0000299

00002920
00002%a2
00002%a4

00002926
00002928
00002%aa

00002%ac
000029ae
00002900
000029b2
000029b4
0000296
000029b8
00002%ba
00002%be
000029¢c0

switchD_0000291a: :caseD_d

1 add +»3p, $0xc
3 ldr __arm cp.2_2]
LAB_000029a0
str 1, [x0, #0x0]=>local_l4
subs 0,20, #0x4
b LAB_000029a0
switchD_0000291a::caseD_e
movs 0, $0x0
14 str r0, [sp, #local_l8]
1ldr x5, [->ADC_RequestQueue]
LAB_000029ac
adds 0,#0x1
add #0x4
strb »$#0x0]=>local_lc
ldr x0, [£5, #0x0] =>ADC_RequestQueue
movs » $0x0
mov 4
mov 2
47 £d bl ssageQueusPut
ldrb 0, [r4, #0x0]=>local_lc
b LAB_00002%ac



Complex Control Flow #17

ECE 561 only: If the number of test cases don’t match, try to explain why.

* Test cases TR_None (0) and TR_End (15) both do nothing, so there is
no case code generated for them.

» Before the jump table, those cases are detected with one test
* They are both handled by this code:

e Subtract 1 from rO . 290c subs ,r0, #0xl
o 0 -> Oxffffffff ...290e cmp $0xd
* 15->14(0x0000000e) ..2910 bhi switchD 000029la::caseD e

* Compare with Oxd (13)
* bhi: Branch if unsigned greater than is true

* Both are higher than Oxd, so branch to caseD_e, which is code which follows
the switch statement



= O

11

12
13
10

switch (t) {

case TR_None:
break;

case TR_Setpoint_High:
// Manually c =
g_set_current =
break:;

case TR_Setpoint_Zero:
// Manually change current setpoint.
g_set_current = 0;
break;

case TR_Flash Period:
g_flash period = 100;
break;

case TR_PID FX Gains:
// Corrupt one of the compensator gains
plantPID FX.iGain = -1000;
break:;

case TR_LCD mutex:
// Take LCD_mutex, don't return it
osMutexAcquire (LCD_mutex, osWaitForever);
break:

case TR_Fill Queue:
// Fill ADC request queue with garbage
Fault_Fill Queue():

ent setpoint.

break;

case IR Disable PeriphClocks:
SIM->SCGC6é = 0;
break;

case TR Disable_All IRQs:

// Disakls Tnrerruscs

_ disable_irq():
break:;
case TR_Disable ADC_IRQ:
// Disable ADC interrupt
NVIC DisableIRQ(ADCO_IRQn):
break:
case TR_osKernelLock:
// Lock kernel - don't let other tasks run
// See details at https://www.keil.com/pac
osKernellock()

break:
case TR_Change MCU_Clock:
// Change MCU clock frequency
MCG->CS = 0x0018
break:;

case TR_Slow_TEM:
TPMO->MOD = 23456;
break;
case TR_Stack Overflow:
n= Ovezflow_Stack();
break;
case TR_High Priority Thread:
// Raise own priority very high, then go i
osThreadSetPriority(osThreadGetId(), osPri
while (1)
DEBUG_TOGGLE (DBG_FAULT_POS) ;
break;
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case TR_End:
break;

Complex Control Flow #20.

ECE 561 only: If the number of test cases ending in infinite loops

don’t match, try to explain what happened.

* In source code
* one case ends in explicit infinite loop: high priority thread (10)

CFG shows three cases ending in infinite loops, partially matching source code.

* In cases for stack overflow (13/d), fill queue (14/3),
compiler in-lined calls to subroutines with infinite loops

00002574 - caseD_a -0 M
switchD_0000291a::...
«.2974 bl osThr etld
..2978 movs rl
...297a bl
Y
0000297 - LAB_0000297¢ -0 W

..297e str
...2980 b

LAB_0000297e
r4, [rS,#0xc])=>DAT_£80££04c

LAB_0000297e

— [0000299c - caseD_d 7;(%:] |

switchD_000029l1a::...
..299c add t,sp,#0xc

«.299% 1ldr rl,[__arm cp.2_2]

Y

[60002520 - LaB 00002920 g/ ~ (]

LAB_000029a0

...29a0 str rl,[t,#0x0]=>local_l4
«..2%a2 subs t,t,#0x4
..2%924 b LAB_000029a0

==} switchD_000029la::...
«.2%9a6 movs t,#0x0
...29a8 str t,[sp,#local_lg]
...2%9aa ldr

09002806 -cased = ¥-0 W

xS, [->ADC_RequestQueue]

M

<«

Y

[000029ac -LAB_0000292c

LAB 000029%ac
..2%c adds t,t,#0xl
...2%ae add
«.29b0 strb
2902 1ldr
«..29b4 movs r2
...29b6 mov
«.29b8 mov

..29ba bl ©
...29be ldrb t,[ _lc
..29c0 b LAB_00002%ac




Complex Control Flow #21 (1 of 2)

The control flow for four different cases merges into a single basic block before reaching the basic block with the
call to osDelay and the pop instruction. Try to explain why the control flow merges for those cases.

* These four cases merge: ‘ SRR DR TR e e
SIM->SCGCé = 0; TPMO->MOD = 2345¢; case TR Flash Period:
break; break; - 7

case TR_Setpoint_Zero: g_flash period = 100;

* All four cases are very similar: they break:
just write a constant value to o e
certain location in memory. To do
this they need to do the following:

* PUF the des.tination address in a ro & &(SIM->SCGC6) ro & &(g_set_current) r0 & &(TPMO->MOD)  r0 ¢ &(g_flash_period)
pointer register (e.g. r0)

* Put the constant value in a rl <0 rl <0 rl & 23456 rl ¢ 100
register (e.g. rl) 7'y

* Store the value to memory STR mem[rl] & r0 mem[rl] & r0 mem[rl] & r0 mem[rl] & r0
r0, [r1]

e All four cases can use the same
store instruction: STR rO, [r1]

* (For two cases, the value written to )
memory will be 0, so the same
instruction can move 0 into rO. p

* The remaining operations in each
case different and get their own
code.



Complex Control Flow #21 (2 of 2)

The control flow for four different cases merges into a single basic block before reaching the basic block with the
call to osDelay and the pop instruction. Try to explain why the control flow merges for those cases.

case TR _Flash Period:

case TR_Slow_TPM: g_flash period = 100;
- , —1 TEMO->MOD = 23456; break;
case TR_Setpoint_Zero: @Eh’“’im -0 W break: )
case TR Disable PeriphClocks: Fegaaliy :he.r.?e § switchD+l
SIM->SCGCé = 0; g _S€t_current = 9; switchD_0000291a: ...
break: break: ..291a add pc,
. = ¥ N
* Each of the four cases gets its [Bo002see -8 /- ) M oozss-s0> /- ) M 0002%6e a0« /- (] M o003 /- ) M
switchD_0000291a::... switchD_0000291a::... switchD_000029la: :... switchD_0000291a: :...
Own COde to Ioad non_ 2968 ldr x0,[__arm cp.2_7] «.2934 ldr 0, [->g_set_current] «.298a ldr 1x0,[__arm cp.2_3] «.2938 1ldr 0, [->g_flash_period]
-.2936 b LAB 000029€a «.298c ldr rl,[__arm cp.2_4] -.293a movs rl,#0xé4
common values w2330 b 1aB_oo0o2se
° A 7
For cases 8 and 2, thg value B v -
written to memory willbe 0. ______ LaB_0000256a
-..296a movs rl,#0x0
The common code to load r0 ~296c b LAB 0000256
with O is placed in BB 296a
Y “=

memory at [r0] is placed in BB
298e for use by all four cases. |
@m'm@.e -0 W

switchD_000029la::...
«:.2990 movs r0,#0x2
-.2992 bl
«.299€ str
2998 add
-.299a pop {r4,r5,r7,

) ) <

* An instruction to storerl to { ] [6000298e - LaB_0000258¢ ¥-0 W
LAB_0000298e

«.298e str rl=>s 05 +2752




Complex Control Flow #22

Do all the cases end in an infinite loop or a control flow edge to another basic block?
If not, which one doesn’t, and why not?

e With my code, all cases end in an infinite loop or a control flow edge
to another block.

* It’s possible that if the compiler didn’t inline a call to a function with
an infinite loop ( , then the
basic block would just end in a subroutine call (BL, BLX instruction)
with no successor BB.
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ADCO_IRQHandler

Examining Function Calling P

Behavior #10 oo .
00.00000‘0 9 O

* 20%: Root node must be - arlih o S
ADCO_IRQHandler

* 30%: All direct calls must be ‘ ‘ ‘ ‘ ‘ . ‘ @ ‘ @ '

Add_FX Multiply_FX Subtract_FX __aeabi_memcpy8 osRtxKernelErrorNotify
included (scale proportlonally

for missing or extra function ' ‘ . ‘

nodes) e~ = o .
* 50%: All indirect calls must be

. . _fpl_femp_InfNaN

included (scale proportionally

for missing or extra function .

nodes) . .



Examining Function Calling Behavior #11

Use Ghidra to create a function call graph for LCD_Start_Rectangle. Compare it with what you would
expect from the source code (located in ST7789.c). What are the differences? How do you explain
them?

) D |ffe rences: LCD_Start_Rectangle

* The source code has multiple |
subroutine calls to
LCD_24S Write_Command and
LCD 24S Write Data LCD_24S_Write_Command LCD_24S_Write_Data

* The Ghidra function call graph has
no subroutine calls.

LCD_Start_Rectangle

* Explanation: The compiler in-lined
the function calls when optimizing
the code (to speed it up).



Source Code vs. Decompiled Code #1

uint32_t LCD_Start_Rectangle(PT_T * pl, PT_T * p2) {
uint32_t n;
uintlé_t c min, c¢_max, r_min, r_max;

// Find bounds of rectangle
c_min = MIN(pl->X, p2->X):;
C max = MAX(pl->X, p2->X);

r min = MIN(pl->Y, p2->Y);
r max = MAX(pl->Y, p2->Y);

// Clip to display size
Cc_max = MIN(c_max, LCD WIDTH-1):;
r max = MIN(r_max, LCD HEIGHT-1);

n = (c_max - ¢_min + 1)*(r_ max - r min + 1);
it n > 0) {
// Enable access to full screen, reset write pointer to origin
LCD_24S Write_Command (0x0022); //column address set
LCD_24S Write Data(c_min >> 8);
LCD 245 | _Write Data(c_min & lef), //start
LCD_ 245 | _Write Data(c_max >> 8);
LCD 245 | _Write Data(c_max & O0xff); //end
LCD 24S  _Write Command(th(ZB), //page address set
LCD 245 | _Write Data(r_min >> 8);
LCD 245 | _Write Data(r_min & O0xff); //start
LCD 245 | _Write Data(r_max >> 8);
LCD_245 Write Data(r_max & 0xff); //end

// Memory Write 0x2c
LCD_24S Write_Command (0x002c);
}

return n;
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Source Code vs. Decompiled
Code #2 (option 1)

» Either option 1 or 2 (next page) is fine

* In Code Browser, Edit -> Tool Options->
Decompiler-> Analysis

Respect readonly flags [

1int32_t LCD_Start_Rectangle(PT_T *pl,PT_T

uint32_t

uint
uint
uint
ushort
uint
uint
uint
pl->X;
p2->X;
(ushort)
if ((int)
(ushort)
}
(uint)
= % 4 | <
}
if ((int)
}
pl->Y
p2->Y
if ((int)
}
s
if (Ox (
}
if ((int)
}

........

‘p2)
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1
2 [uint32_t LCD_Start_Rectangle(PT_T *pl,PT_T *p2) :2
Source Code vs. ¢ :
° S uint *puVar ::
o 3 uint32_t B
D 4 uint uVa =
ecompiled Code :
9 uint u A
. 10| ushort u 5;
11 uint u =
#2 (option 2 = :
13| uint =
H 63
15 = _arm cp.ll 0; -
. : :
* In Code Browser, Edit -> Pt c
. 190 if ((int)uVar9 <= (int)uVar4) { o5
Tool Options-> 20 uvar = tushortiavar; =
. . 2l '} 70
Decompiler-> Analysis (8 - s 32
24 o
25 A
Respect readonly flags 2 [ "
27 o
. 77
29| .
30 -
31 o
32 { .
33 =
34 -
35 -
36 { e
37 -
8 1} 27
39 (int)uvar7) { 28
g uva HVars 89
41 } 90
42| uVar2 : - (uWard & OXf££f)) + 1); |gi
43 92
44 93
45 94
4€ as| }
47 96| return r2;
48 97}




Source Code vs. ‘
Decompiled Code #3  mmzii

e Each MIN or MAX macro has o S5

become a compare instruction, a
conditional branch, and a move
instruction.

00001e3e i ~

Y

00001e46 g ~




Source Code vs. Decompiled Code #4

(option 1)

* These are
addresses that
correspond to the
fast GPIO registers |

i:

for FGPIOC

nn n o~ 1
Lyl
t
t
t
t
t
q
—
"
.
h
h
"
h
)
~—

(Chapter 41 of

F80F_F080

Port Data Output Register (FGPIOC_PDOR)

KL25 SF Reference
Manual, Rev. 3)

F80F_F084

Port Set Output Register (FGPIOC_PSOR)

F80F_F088

Port Clear Output Register (FGPIOC_PCOR)




Source Code vs. Decompiled Code #5, #6

5. One cast does appear, performing an unsigned extension of a halfword from r3
into a full word in r5

22 = (uint)
LAB 00001e40 23 if (0Oxee < ) |
J0001e40 9d b2 uxth 24 = Oxef;
0000le42 ef 2d cmp , $0xef 25 }

6. Most of the casts don’t appear in the object code — for example a conditional
branch is highlighted as implementing the code. The casts are probably in the
source code to clarify how the comparisons are performed.



Source Code vs. Decompiled Code #7, #8

7. The compiler inlined the function calls.
This makes the program faster.

8a. Without Respect readonly flags
checked, the decompiler omits all but the
last writes to _DAT_f80ff080,
_DAT_f80ff088, and _DAT_f80ff084
because it didn’t know they were control
registers (not regular memory), so each
write matters.

8b. With Respect readonly flags checked,
the decompiler includes all writes to those
addresses.

Respect readonly flags )

= (( - & OxEf£ff)) + 1) * (( - ( & Ox£fff)) + 1);
o

Respect readonly flags



